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INTRODUCTION 
 
This document is intended as a guide for those who have purchased Nistune and despite 
reading all the documentation, are still having trouble getting started. You did read the 
documentation didn’t you? 
 
If not then please consider doing so. Just go to www.nistune.com and click on the 
documentation link. There’s a lot of information there and it’s worth your while setting aside 
some time and having a good read. 
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1. Problem Solving Flow Chart 
 
Use the following flow chart to assist with sorting out connection issues 
 
1. Are you able to connect to the vehicle using Nistune? 

 
YES – Question 14 
NO – Question 2 
 

2. Have you selected the correct vehicle selection for the ECU you are using?  
 

 
 
YES – Question 3 
NO – Select the matching ECU part number in File > Select Vehicle. Check the Nissan ECU part 
number matches the part number (and description in the list) 

 
3. Are you using a vehicle with a Nistune Type 1 board fitted to the ECU? 

 
YES – Question 4 
NO – Type 2 – Type 5 board ECU refer to Question 7 

 
4. Type 1 ECU: Does Nistune recognise the Type 1 board? Vehicle must have ignition on for 

Windows to recognise the device. It will display the following error if the Type 1 board is not found: 
 

 
 
YES – Board is recognised proceed to Question 6 
NO – Above error printed because board not found Question 5 
 

5. Inside Control Panel > Device Manager is your Nistune board recognised? It will display as ‘Nistune 
USB communications device’ or ‘Nistune Type 1 board’.  
 

 
 
YES – Make sure your Type 1 drivers are installed correctly. Refer to Section 4.3 USB Drivers - 
Type 1 boards. If installed correctly then refer to Question 6 
NO – There is a problem with the Type 1 board or the USB cable. Make sure your USB connector 
is fitted to the Type 1 board correctly and the board is installed correctly to the ECU. Windows 
cannot see the USB device. Try another USB cable if there is still an issue.  
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6. Do you get any other type of error message reported such as ‘No data received’? 

 

 
 
YES – Refer to Section 6.1 Type 1 boards regarding limp mode. Also refer to ‘Type 1 Nistune 
Diagnostics Document’ on the Type 1 hardware installation document page. 
NO – Contact Nistune for further support with board information and any information which you can 
provide us. 

 
7. Consult with Type 3-5 boards: Inside Nistune under File > Configuration > Nissan Consult 

Options > Port can you see your consult cable in the drop down list? 
 

 
 
YES – Question 9 
NO – Question 8 
 

8. If the consult cable is not in the drop list then check if your cable is showing inside Control Panel > 
Device Manager and is installed correctly (with no errors) 
 

 
 
Is your cable a PLMS USB consult cable? 
 
YES – Refer to Section 7 Checking PLMS USB consult drivers and make sure drivers are installed 
correctly. Note that each USB port installs its own set of drivers and assigns a different COM port.  
 
NO – Refer to your manufacturers consult cable instructions and check that their cable works with 
their supplied consult software before trying it with Nistune 
 

9. Is your consult cable a PLMS USB consult cable? 
 

 
 

YES – PLMS Cable: Make sure that when your cable is plugged into your laptop the RED LED is lit. 
When you attempt connection to the ECU the green ‘Rx’ light should flicker. 
 
Proceed to Question 10 
 
NO – Check that the cable works on your vehicle or another Nissan vehicle where available to 
check their cable works with their supplied software before attempting to use it with Nistune 
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10. Does the Rx light on the PLMS consult cable flicker when you attempt to connect? 

 
YES – Question 11 
NO – There is no Rx light activity when connecting to the consult COM port in Nistune. Contact 
PLMS Developments regarding the cable 
 

11. Does the orange Tx light on the cable respond to the green Rx light flicker when attempting to 
connect? 
 
YES – Check that the correct vehicle has been selected inside Nistune. If the Tx light is flickering 
then the ECU is responding to communications and Nistune should be connecting 
NO – Question 12 
 

12. Does the vehicle have a Nistune board installed?  
 
YES – Question 13 
NO – Check the ECU wiring. Has the vehicle had an engine transplant or any rewiring of the 
communications port? There may be an issue with the wiring preventing connectivity to the 
standard ECU. Try another Nissan vehicle where possible. Refer to Section 4.6 Consult port wiring 
issues. 
 

13. Were you able to connect to the ECU prior to the Nistune board being installed or able to connect to 
another Nissan with the consult cable? 
 
YES – Check that your ECU is operating correctly and not running limp mode 

- Section 6.2 Type 2 boards 
- Section 6.3 Type 3 boards 
- Section 6.4 Type 4 boards 

 
Note: If the ECU is an ER34/WC34 RB25DET and the ECU experiences a disconnect the vehicle 
may require a power off, wait, power on sequence to restart the ECU. You will then be able to 
reconnect to the vehicle. 

 
NO – Contact PLMS about the consult cable connectivity issues 
 

14. Consult Initially Connects: Are you experiencing disconnection issues after initial connection is 
established? 
 
YES – Question 15 
NO – Ensure you have selected the correct vehicle inside Nistune. If correct vehicle is selected 
make sure for Type 3-5 ECUs that you have moved the ECU jumper to external board mode. If this 
has been moved, restore the ECU to factory mode and remove the board and retry connecting. 
Refer to your installation manual for the ECU jumper positions. Otherwise contact Nistune for 
further support 
 

15. Does the vehicle disconnect after cranking or during high RPMs but maintains a connection with 
ignition switched on but engine not running? 
 
YES – Electrical noise associated with engine operation is triggering interference with consult 
communications to the ECU. Refer Section 5 Consult Dropping Out.  
NO – Check your consult cable. Wiggle the consult cable wires whist connected. If the connection 
drops when the cable is moved then replace the cable. Otherwise contact Nistune for further 
support
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2. Limp Home mode 
 
Nissan ECUs all have some sort of limp home capability built in. The type of limp mode depends on 
what is occurring with the ECU 
 
Sensor limp mode 
 
In the cases where AFM signal is not present, a default AFM value (enough to allow the vehicle to rev 
upto 2000rpm before leaning out the engine) will be used. Where the coolant temperature sensor is not 
present, a default temperature value will be used in the tables indexed by temperature. Similarly other 
sensors will use default values when their inputs are not valid 
 
Missing or out of range signals will be reported to the user via the consult Diagnostic Terminal Codes 
available inside Nistune as well as via the diagnostic LEDs (where available on the ECU). 
 
Processor limp mode 
 
Later model ECU's have an internal processor limp mode also. When the program from the ECU chip 
or daughter board is not functioning, an auxiliary processor will inject a set pulse width for each 
injection regardless of other sensor inputs and ECU program. When in limp mode, this will be indicated 
to the operator through the means of a LED in the ECU or the  
 
Note: Earlier model ECU's such as the older JECS style used in R31, Z31, S12 etc ECUs only have a 
single processor and do not support processor limp mode. Later model ECUs such as ER34 Skyline 
and WC34 Stagea do not have processor limp mode. The ECU will be unable to function at all if there 
is a problem and the vehicle will not start. 
 
Processor limp mode is entered when a major fault has occurred. Major faults occur with anything to do 
with the ECU micro code being unable to run. This can be a result of the various factors where the 
processor is unable to execute the code properly. If it occurs after resoldering and resoldering then 
there may be an introduced problem causing the ECU to go into processor limp mode. 
 
The processor bus on any ECU consists of 8-16 data lines and 16 address lines plus control lines. If 
any of these lines is broken or shorted during the installation process, it will stop data flowing correctly 
on the lines and the ECU will not be able to run properly. 
 
Symptoms vary depending on engine (specifics covered in the relevant section for each engine) but 
one thing is constant across all engines – Consult communications will NOT be active in limp mode. So 
you will not be able to connect to it. 
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3. Trouble starting engine – some tips 
 
The golden rule here is that if the engine isn’t starting (or starts and runs very badly) then don’t keep 
trying. Work out what the problem is or you’ll cause yourself extra trouble. EFI engines will become 
flooded with fuel very quickly if they are continuously cranked and the fuel is not ignited. This is a real 
trap. Because the spark plugs become wet with fuel - so even after the fault is fixed the engine won’t 
fire. So if you’ve had trouble and the engine has been cranked for awhile then pull the plugs. If they 
smell strongly of fuel then dry them out before continuing. 
 
If the engine has been starting but is running very poorly or in limp mode then it’s very easy to foul the 
plugs. Usually the engine will run worse and worse until finally the plugs won’t ignite the mixture any 
more and the engine stops. When the plugs are removed they’ll be black with carbon, which can be 
cleaned off and away she’ll go again. The tip here is the same as for wet plugs – if it’s not running right 
then don’t keep trying as you’ll only make things worse!   
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4. Consult Connection Issues 
 
If you can’t connect to consult, there are a few reasons why this might happen: 
 
4.1 Limp Home Mode 
 
If the ECU has gone into limp mode then communication with ECU will not be possible (see section 
Error! Reference source not found.). Make sure the ECU is not running in limp home mode and 
revert to factory ROM installation if necessary to try and get the vehicle running first, and in the case of 
Type 2 - 4 boards a working consult connection prior to using the daughter board 
 
4.2 USB Drivers 
 
If the drivers have not been installed correctly then Nistune will be unable to see the cable or the 
vehicle. At the end of installing Nistune ensure that you have ticked the driver installation 

 

 
 

4.3 USB Drivers - Type 1 boards 
 
If you are using a Type 1 board and Nistune tells you that the drivers haven't been installed correctly 
then you will not be able to connect. It is necessary to install the drivers prior to connecting to your 
vehicle. 
 
Reinstall Nistune and ensure the tickbox for drivers has been ticked. Inside Control Panel > System > 
Device Manager > Universal Serial Bus Controllers you should see ‘Nistune USB communications 
device’ 
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4.4 USB Drivers - Consult cable (Used with Type 2 - 4 boards) 

 
If you’re using a PLMS USB Consult cable and the drivers have not been installed correctly then no 
communications will happen until this is fixed. It’s easy to check if it’s a USB driver issue - the laptop 
will not be able to communicate with the cable at all 
 
When you hit “Consult” in Nistune you should see the green LED blink briefly. This is the information 
going from laptop to ECU. If there’s a driver problem then you won’t see the green LED flash as 
Nistune will not be able to access the COM port of the laptop. Driver installation instructions are 
provided with the Consult cable but are also available at www.plmsdevelopments.com/usb_drivers.htm.  
 
To check if your drivers have installed correctly just go to My Computer - Control Panel - System - 
Hardware - Device Manager, Ports. If all is well you should see “PLMS USB Consult Cable” in the list of 
ports. If either of these devices has an exclamation mark (!) against them then you will need to reinstall 
the drivers for the cable. Do this by double clicking on the device and then click the Driver tab and 
reinstall the driver. 
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4.5 Incorrect Vehicle Selected 
 
You must have the correct vehicle selection (address file) for your engine loaded in Nistune. Address 
files are included with Nistune and depending on connection type are usually determined when 
connecting to your ECU. File > Select Vehicle and make sure you have selected the correct vehicle you 
are trying to connect to. 
 
4.6 Consult port wiring issues 
 
Some customers have had situations where the consult port does not function in their vehicle. This may 
be due to engine transplant, bad wiring or other reasons. 
 
For the consult port to function you must have the TX (Transmit), RX (Receive), CLK (Clock), Ignition 
(12 volts) and Ground wires going to the consult plug from the ECU 
 
Most engine transplants do not wire the ECU loom into the instrument loom correctly, if at all. This 
means that the consult lines which go via the instrument loom to the consult plug (normally near the 
fusebox or streering wheel panel area) are not connected. 
 
 
Refer to our Nistune MAF and ECU Wiring document on the Nistune website under Support > 
Documentation > General Documentation for wiring details. 
 
Note that later model vehicles including ER34 GTT, R34 GTR, N15 SR16 etc do not have CLK lines 
going to the consult port. If you transplant into a vehicle without the CLK line then you will need to 
splice the CLK line into the ECU plug and wire either to the consult plug via the instrument loom, or 
preferably cut and remove the consult plug and wire directly into the ECU loom. 
 
To check the consult plug, use a multimeter in continuity mode. Images on the next page show the 
various connectors for ECUs and lines that go to the consult plug 
 
The consult 12V and ground lines must show power on the meter when the ignition switch is turned on. 
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5. Consult Dropping Out 
 
(a) Disconnects randomly 
(b) Disconnects when RPMs are high 
(c) Disconnects during starting 
  
5.1 Problem 
You may have electrical noise from the vehicle gets into the Type 1 USB cable or your consult cable, 
that so much noise occurs that it disconnects the laptop.  
 

 
 

USB Communications scope trace showing noise 

 
Electrical noise is generated by the engine, ignition system and also injectors. It feeds back through the 
signal lines back to the ECU. However the ignition system is grounded via the plugs to the engine and 
the injectors to the ECU. 
 
That electrical noise is getting into your laptop from the ECU causing the disconnects via the USB bus. 
This can occur with Type 1 boards or using a USB Consult cable with Type 2-5 boards. 
 
5.2 Background 
 
We have followed the design rules for USB with appropriate filtering and grounding. The USB bus is 
differential line pair, which means that if a spike enters the cable then both lines should rise/fall at the 
same time. However get too much noise and start getting a differential difference and then you start to 
lose data  
 
The higher the RPMs, the more electrical noise that you get. I measured the USB lines with a scope 
and noted this as RPMs it increases so does the noise (ignition noise can feedback through the 
system)  
 
Put a lot of noise in continuously and no data can get over the bus (communications will fail and 
windows will fail to read the device any more). This is when you get the Nistune disconnect  
 
With Type 1 boards we have added filtering and decoupling capacitors for a start, but that’s not 
enough. Nistune software has had extra features added to effectively drop and reconnect the device in 
the event of serious communication issues. PLMS cables have been designed with extra filtering 
circuitry to smooth out noise spikes at various frequencies and are more effective than other consult 
cables on the market. Use a cheaper cable and you may experience more communications issues. 
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5.3 Solutions 
 
These solutions are from discussions with many customers and workshops over the years who have 
had these issues. Many are caused by a problem with the vehicle which was unnoticed otherwise and 
the majority of connection issues are in vehicles which have had engine transplants! 
 
Check list: 
 

• Sufficient grounding of engine to chassis, chassis to battery and ECU to chassis are required. The 
grounding absorbs the majority of electrical noise. Your path of grounding should be from: 
 

(a) Battery to engine block  
(b) Battery to chassis 
(c) ECCS grounding wires to plenum (which then go back to ECU) 
 
Take note of these in particular installations where battery in boot relocation is noted to cause 
problems and grounding battery to chassis only (and not directly to engine) is not sufficient for 
suitable grounding required to maintain a stable connection 

 

• Check all grounding points are clean and secure for these items. Remove the connectors and use 
a wire brush or fine and paper to clean the terminals/connectors and the areas they bolt to.  
 

• Note your battery voltage reported by your gauges and consult in Nistune. If there is a significant 
drop between reported voltage at the ECU and what you measure directly at the battery terminals then 
you may have an issue there. 

 

• Check the ECU earthing connection. This normally bolts to the top of the plenum on the engine 
from the engine loom. 
 

• Check the ignition system capacitors in your loom in the engine bay are clean and secure as these 
absorb the spark signal  
 

• Check and clean distributor cap points and button 
 

• Check ignition system high tension leads and low voltage wiring going to coil and power transistors 
or coil packs 
 

• Check voltage from alternator and check monitor if it goes low or drops down under load. The 
battery will hold 12 volt power normally and the alternator will usually maintain 14 volt DC power to the 
vehicle. Problems with the battery will result in the voltage dropping under 14 volts under low engine 
speed. Problems with the alternator will result in the vehicle voltage not reaching 14 volts when the 
engine has been running 

 

• Check the alternator for reverse voltage or Alternating Current. This indicates a problem in the 
diodes used by the alternator when it converts Alternating Current to Direct Current. Using a volt meter 
in AC setting or scope to monitor for reverse voltage spikes may assist in diagnosing an issue with the 
diodes. 

 

• Using an AM radio not tuned to any particular station has been useful in assisting some people 
locate sources of electrical interference with their vehicles. As the static of the radio increases around 
particular components, it indicates a potential source of electrical noise which may be affecting your 
communications 
 

• Use a clip on ferrite core which connects around the USB lead and use a shorter USB cable. 
These are available from electronics shops such as Jaycar Electronics. 
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• Make sure ECU is installed to chassis and that the USB connection for Type 1 board is mounted to 
the frame of your ECU and your ECU is firmly grounded to the chassis. The electrical noise should be 
absorbed via the chassis 
 

• If still having problems with the laptop on Type 1 boards, try running from battery only and then 
also try grounding USB point going into laptop (ie shield) to an earthing point such as cigarette lighter 
ground  
 
A properly grounded vehicle will not disconnect. I found during my testing that particular laptops were 
prone. My newer Dell Inspiron and Vostro laptops never miss a beat on my Type 1 RB30 but with my 
last car the older dell latitude would suffer the issue you saw until I grounded the ECU and laptop itself 
to the chassis to absorb the noise going into the chassis. 
 
5.4 USB Driver Tweaking Solutions  
 
If after doing the above you are still having disconnects on the PLMS and Blazt USB consult cables 
that use the FTDI USB chip, you can tweak the latency settings in the drivers which have been 
reported to work well by some users who have provided us with feedback. 
 
1. Go into Device Manager and select properties on the USB COM port matching your USB consult 
cable 
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2. Click on 'Port Settings' tab 
 

 
 
3. Click on Advanced and change the Latency Timer (msec). Based on user feedback try 
experimenting with values between 5 and 50+ msec. The less latency means that frames may overlap 
on slower machines but on faster machines the data may take too long. 
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6. Checking ECU functionality 

 

6.1 Type 1 boards 

 

 
 
Check section 4 if you can’t connect to your ECU.  
 
Signs of limp mode on common ECUs: 
 

1) CR31 RB30, VL/VLT RB30ET, S12 CA18, Z31 VG30 
 

• Both ECU LEDs will either stay lit or pulsate 

• Fuel pump may pulsate or stay on continuously. 

• Will not be able to connect to the ECU. 

• Vehicle will not start whilst trying to crank 
 
2) S13 CA18DET 
 

• ECU LEDs will be off or both LEDs will pulsate 

• Fuel pump may stay off or pulsate or stay on continuously. 

• Will not be able to connect to the ECU. 

• Vehicle will not start whist trying to crank 
 
3) S13 KA24E 
 

• ECU LEDs will be off or both LEDs will pulsate 

• Fuel pump may stay off or pulsate or stay on continuously. 

• Will not be able to connect to the ECU. 

• Vehicle will not start whist trying to crank 
 
  
2) J30 VG30E 

• ECU red LED will either stay lit or both LEDs will pulsate 

• Will not be able to connect to the ECU. 

• Vehicle may start in limp mode but will not rev above 2000rpm without leaning out 
 
 
3) A31 RB20DET 
 

• ECU red LED will flash or both LEDs will pulsate 

• Will not be able to connect to the ECU. 

• Vehicle may start in limp mode but will not rev above 2000rpm without leaning out 
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These ECUs will typically go into limp mode or stop working when: 
 
(a) Socket is not correctly soldered  
(b) Post install damage to pads tracks on ECU 
(c) Jumpers have not been shifted correctly 
(d) Connector is not correctly installed 
(e) Incorrect ROM image loaded on board 
 
Diagnosis  
 

• If you have these problems then try fitting the factory chip back where the board is currently 
installed and see if the above problems still occur. If so then you may have a problem with your 
resocketing. If the ECU does not run when the factory chip is installed correctly, then you need to 
check the soldering of the 28 pin socket in your ECU. 
 

• For earlier model dual ROM chip ECUs where jumpers needed to be changed, check you have 
changed the jumpers as instructed for your ECU in the Type 1 manual. 
 

• Soldering of 28 pin socket. Clean flux from all joints and inspect each joint using an eyeglass and a 
good light. In particular look for solder bridges between pins. Look for any cracks in tracks caused by 
pushing to hard with the desoldering gun. 
 

• If you only have problems with the Nistune board installed check the 4 way CPU ribbon cable – this 
connects the Nistune board to some control signals in the ECU. Check you have the correct wires 
soldered to the CPU and they are in the correct order as per the Type 1 manual. 
 

• Then check the correct plug is pushed into the socket connectors on the Type 1 board. The CPU 
cable plug should be on the X1 connector and the USB cable plug should be on the X2 connector. 
 

• Then check pins on the Nistune board to make sure they have not been damaged during fitting. 
You will need to remove the board to check. Be careful not to damage the pins during removal! Use a 
flat blade screw driver between the board and socket and carefully pry underneath being careful not to 
damage parts on the Nistune board, lifting at the edge and rock the board so it carefully removes 
without bending the pins and causing further damage! 
 

• Check the ECU part number written on the board matches your ECU where possible. We program 
and test the boards prior to sending so we know each board works correctly when you receive it 
 

• You can next check continuity of the CPU connector from where it is soldered from the ECU into 
where the connector plug solders into the Nistune board. This will verify each crimp connection on the 
connector is conducting electricity. 
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6.2 Type 2 boards 
 

 
 
Check section 4 if you can’t connect to your ECU. 
 
Signs of limp mode on common ECUs: 
 
1) R32 RB20DET, BNR32 RB26DETT 
 

• ECU red LED and Exhaust Warning Light on dash will flash on / off 

• Will not be able to connect to the ECU using consult 

• Vehicle may start in limp mode but will not rev above 2000rpm without leaning out 
 
2) Z32 VG30DE/DETT, M30 VG30E 
 

• ECU red LED and Check Engine Light (CEL) will stay on 

• Will not be able to connect to the ECU using consult 

• Vehicle may start in limp mode but will not rev above 2000rpm without leaning out 
 
These ECUs will typically go into limp mode or stop working when: 
 
(a) Socket is not correctly soldered  
(b) Post install damage to pads tracks on ECU 
(e) Connector is not correctly installed 
(d) Incorrect ROM image loaded on board 
 
Diagnosis 
 

• If you have these problems then try fitting the factory chip back where the board is currently 
installed and see if the above problems still occur. If so then you may have a problem with your 
resocketing. If the ECU does not run when the factory chip is installed correctly, then you need to 
check the soldering of the 28 pin socket in your ECU. 
 

• Soldering of 28 pin socket. Clean flux from all joints and inspect each joint using an eyeglass and a 
good light. In particular look for solder bridges between pins. Look for any cracks in tracks caused by 
pushing to hard with the desoldering gun. 
 

• If you only have problems with the Nistune board installed check the 4 way CPU ribbon cable – this 
connects the NIStune board to some control signals in the ECU. Check you have the correct wires 
soldered to the ECU board in the correct order as per the Type 1 manual. Pin 1 is marked on the 
connector plug in small wiring (purple wire) 
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• Then check pins on the Nistune board to make sure they have not been damaged during fitting. 
You will need to remove the board to check. Be careful not to damage the pins during removal! Use a 
flat blade screw driver between the board and socket and carefully pry underneath being careful not to 
damage parts on the Nistune board, lifting at the edge and rock the board so it carefully removes 
without bending the pins and causing further damage! 
 

• Check the ECU part number written on the board matches your ECU where possible. We program 
and test the boards prior to sending so we know each board works correctly when you receive it 
 

• You can next check continuity of the CPU connector from where it is soldered from the ECU into 
where the connector plug solders into the Nistune board. This will verify each crimp connection on the 
connector is conducting electricity. 
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6.3 Type 3 boards 
 

 
 
Check section 4 if you can’t connect to your ECU. 
 
Engine running badly is defined as engine may start but idle will be poor and engine will overfuel badly, 
resulting in obvious clouds of partially burnt fuel coming from exhaust. Engine may not run at all if 
injectors and/or AFM are non-standard. May lean out when rev exceed 2000rpm 
 
Signs of limp mode on common ECUs: 
 

• Check engine light and/or ECU LED will stay on 

• Will not be able to connect to the ECU using consult 

• When IGN is turned on fuel pump will only pulse on momentarily rather than running for 3 to 5 
seconds. 

• Engine will not run correctly. Engine may start but idle will be poor and engine will overfuel badly, 
resulting in obvious clouds of partially burnt fuel coming from exhaust. Engine may not run at all if 
injectors and/or AFM are non-standard. May lean out when rev exceed 2000rpm 
 
If you’ve performed the NIStune board install yourself and the ECU has gone into limp mode then 
please check the following: 
 

• Soldering of 20+20 header. Clean flux from all joints and inspect each joint using an eyeglass 
and a good light. In particular look for solder bridges between pins and slugs of solder on the ECU 

• Check that tracks have not been cut by pushing too hard on the desoldering gun 

• Check that you have moved the necessary jumper(s) for the ECU to use the daughter board 

• Check the part number on your board matches your ECU number when possible 
 
If you are still having problems then remove the daughter board, and put the ECU jumper back to 
factory position. Check that the ECU functions as normal with the jumper in factory position and just the 
header pins soldered in. 
 
Remember, we test every board in an ECU before shipping, so we check the board works before 
posting them out to you 
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6.4 Type 4 boards 
 

  
 
 
Check section 4 if you can’t connect to your ECU. 
 
Engine running badly is defined as engine may start but idle will be poor and engine will overfuel badly, 
resulting in obvious clouds of partially burnt fuel coming from exhaust. Engine may not run at all if 
injectors and/or AFM are non-standard. May lean out when rev exceed 2000rpm 
 
Signs of limp mode on common ECUs: 
 

• Check engine light and/or ECU LED will stay on 

• Will not be able to connect to the ECU using consult 

• When IGN is turned on fuel pump will only pulse on momentarily rather than running for 3 to 5 
seconds. 

• Engine will not run correctly. Engine may start but idle will be poor and engine will overfuel badly, 
resulting in obvious clouds of partially burnt fuel coming from exhaust. Engine may not run at all if 
injectors and/or AFM are non-standard. May lean out when rev exceed 2000rpm 
 
If you’ve performed the Nistune board install yourself and the ECU has gone into limp mode then 
please check the following: 
 

• Ensure that the connector has been soldered in the correct direction! This is designated by pin 1 
on the adaptor board having a square pin. This should like up to pin 1 on the ECU connector pads. The 
adaptor board should face correct orientation such that the adaptor board fits correctly to Type 4 board 
when installed in the ECU.  

• Desoldering of the pads and soldering of the connector is a delicate job. Ensure that all holes are 
open before inserting the connector cable. Ensure that none of the cable wires bend when inserting 
into the ECU pad holes. When soldred, make sure that solder has flowed right through. Check the end 
pins have soldered to the top side of the ECU 

• Check that tracks have not been cut by pushing too hard on the desoldering gun 

• Check that none of the connector strip wires have broken through too much bending on the 
adaptor board 

• Check that you have moved the necessary jumper(s) for the ECU to use the daughter board 

• Check the part number on your board matches your ECU number when possible 

• Use a multimeter in continuity mode to check adaptor pin from the board to the ECU 

• Make sure that solder has flowed all the way through the solder pads. Check the joints from the 
top. If the iron is not hot enough then use flux and a small part of solder to heat from the top without 
melting the strip plastic 
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If you are still having problems then remove the daughter board, and put the ECU jumper back to 
factory position. Check that the ECU functions as normal with the jumper in factory position and just the 
header pins soldered in. Remember, we test every board in an ECU before shipping, so we check the 
board works before posting them out to you 
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7. Checking PLMS USB consult drivers 
 
To check if your drivers have installed correctly just go to My Computer - Control Panel - System - 
Hardware - Device Manager, Ports. If all is well you should see “PLMS USB Consult Cable” in the list of 
ports.  
 

 
 
If either of these devices has an exclamation mark (!) against them then you will need to reinstall the 
drivers for the cable. Do this by double clicking on the device and then click the Driver tab 
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Click Update Driver 
 

 
 
Click 'No' for searching the computer 
 

 
 
Click 'Install from a list or specific location' 
 
Drivers are located in the following folders when you install Nistune 
(Depending on the version of windows you are running) 
 
C:\Program Files\NIStune\FTDI_Win2K_XP_Vista_Drivers 
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C:\Program Files (x86)\NIStune\FTDI_Win2K_XP_Vista_Drivers 
 

 
 
After these steps the driver should be installed, and once this procedure is performed for both the USB 
portion and the COM port portion of the 'PLMS USB Consult Interface' it should be able to work
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TERMS AND CONDITIONS  
Nistune Developments has performed necessary measures to ensure that the Nistune software and boards are built to high 
standards. By using this product you agree to the following terms: 
 
IMPORTANT - READ CAREFULLY: This License Agreement (Agreement) is a legal agreement between you and Nistune 
Developments for the software product Nistune (Software) and any computer chips, circuit boards or any other physical carrier 
or medium on which the Software is loaded or programmed (Hardware).The Software includes computer software and 
programs, printed materials and electronic documentation. By installing the Software and Hardware, copying or any other use 
of the Software, you agree to the terms of this Agreement. If you do not agree to the terms of this Agreement, you are not 
allowed to use or copy the Software.  
 
1. GRANT OF LICENSE 
 
Individual User Licence: 
If you purchase an Individual User Licence, you are granted a licence as a single user of the Software And are authorised to 
install and use it on up to five (5) vehicles, but you may not install the Software for any other person, and may only make a 
single backup copy of the Software.  
 
Commercial User Licence: 
If you purchase a Commercial User Licence, you are granted a licence as a commercial user of the Software And are 
authorised to install and use it on an unlimited number of vehicles, but you may not install the Software for any other person, 
unless you have a written Reseller Agreement  with Nistune Developments, and may only make a single backup copy of the 
Software.  
 
Use of the software by both Individual and Commercial Users: 
The Software may be installed on multiple computers belonging to you for so long as those machines remain your property.  
Regardless of other rights, the author of the software product is allowed to terminate this license agreement if you offend 
against the terms and conditions of this agreement. If so, you will have to remove and destroy all copies of the Software and 
its components. 
 
2. INTELLECTUAL PROPERTY RIGHTS 
You may not copy, modify or distribute the Software except under the terms given in this Agreement. You may not sublicense 
the Software or in any way place it under any other licence than this one. The Software is protected by the intellectual property 
laws of  Australia and international intellectual property treaties. You acknowledge that no intellectual property in the Software 
passes or accrues to or vests in you and that your rights in the software are limited to such use as is specified in this 
Agreement. 
 
3. TITLE AND RISK 
At all times, title in the Software  remains with Nistune Developments. Risk in the Software and Hardware passes to you upon 
despatch to you.  
 
4. TERM 
Your licence is effective upon your acceptance of this agreement and installing the Software and Hardware. This agreement 
will continue indefinitely unless terminated by reason of your breach of this Agreement.  
 
5. DECOMPILING 
You agree not to reverse engineer or allow a third party to reverse engineer the Software, change, split, decompile, 
disassemble or translate the Software in part or in whole, without prior written consent from Nistune Developments, or except 
as permitted under applicable law. 
 
6. RESALE 
Resale by Individual Users: 
A holder of an Individual User Licence may only sell that licence to a third party if: 
a. Nistune Developments consents to the sale in writing; and 
b. the third party agrees in writing to be bound by identical obligations to those in this Agreement. 
 
If you sell your Individual User Licence, you are no longer authorised to use the Software. Resale of your Individual User 
Licence does not enable the Software to be used on more than five vehicles in total. 
 
 
Resale by Commercial Users 
If you hold a Commercial User Licence, the Software may only be resold by you if you have a current written Resellers 
Agreement with Nistune Developments. Only Commercial User Licence holders may obtain Resellers Agreements. In reselling 
the Software, you agree that: 
a. you will ensure that any person you sell the Software to (Your Clients) execute an agreement in favour of Nistune 
Developments in similar form to this Agreement, obliging Your Clients to observe like obligations to those of an Individual User 
under this Agreement; and 
b. You agree to indemnify us against all claims, losses, costs, liability and damages which we may incur, whether directly or 
indirectly, in connection with or arising from: 
 i. any claim whatsoever brought against us by Your Clients relating to their use of the Software; 
 ii. the use of the Software by you or Your Clients; 
 iii. the unauthorised replication of the Software or onsale of the Software by Your Clients; 
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 iv. your installation of the Software on Your Client’s computer;  
v. your breach, our Your Clients’ breach, of this Agreement; or  
 vi. any other action by Your Clients related to their purchase of the Software from you. 
 
For the avoidance of doubt, this indemnity shall extend (without limitation) to any third party claims against us, any loss or 
damage to property, and any injury to, or death of, any person. 
 
7. INDEMNITY 
You indemnify us against all claims, losses, costs, liability and damages which we may incur, whether directly or indirectly, in 
connection with or arising from: 
 
any negligent act, omission or wilful misconduct by you or your officers, employees, subcontractors or agents in the use of the 
Software or Hardware;  
 
any defect in your installation of the Software or Hardware, or your use of the Software or Hardware; or 
 
your breach of the Terms. 
 
For the avoidance of doubt, this indemnity shall extend (without limitation) to any third party claims against us, any loss or 
damage to property, and any injury to, or death of, any person. 
 
8. UPDATES 
Nistune Developments may, from time to time, revise or update the Software or Hardware. In so doing, Nistune Developments 
incurs no obligation to furnish such revision or updates to you. 
 
9. WARRANTY 
The author of this Software has verified as best as possible that the main features and functions of the Software and 
Hardware work as described when used normally on compatible equipment. Due to the complexity of computer software, we 
can not guarantee that the software or documents do not contain errors or works without intermissions on any equipment and 
software configuration. To the extent permitted by law and except as set out in this Agreement, all express or implied 
warranties, guarantees and conditions relating to the Software and Hardware, however arising, are excluded.  
 
10. DISCLAIMER OF LIABILITY 
 
NO LIABILITY FOR CONSEQUENTIAL DAMAGES. IN NO EVENT SHALL NISTUNE DEVELOPMENTS BE LIABLE FOR 
ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT 
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE 
SOFTWARE OR HARDWARE, EVEN IF NISTUNE DEVELOPMENTS HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. 
 
IN NO EVENT WILL NISTUNE DEVELOPMENTS BE LIABLE FOR ANY COMPUTER DAMAGE, VEHICLE DAMAGE, 
PERSONAL INJURY, DEATH, FINES, LAWSUITS, PROSECUTION, LOST PROFITS, LOST DATA, INCORRECT DATA, 
ENVIRONMENTAL DAMAGE, GOVERNMENT, LAW AND REGULATORY VIOLATIONS OR ANY OTHER INCIDENTAL OR 
CONSEQUENTIAL DAMAGES THAT RESULT FROM USE OR INABILITY TO USE THE SOFTWARE OR HARDWARE 
 
THE SOFTWARE AND HARDWARE IS NOT INTENDED FOR USE IN OPERATION OF MOTOR VEHICLES AND/OR 
MACHINES WHERE THE USE, FAILURE OR MISUSE OF THE SOFTWARE OR HARDWARE COULD LEAD TO DEATH, 
PERSONAL INJURY OR PHYSICAL OR ENVIRONMENTAL DAMAGE AND OR VIOLATE ANY ENVIRONMENTAL, 
SAFETY, TRANSPORTATION OR OTHER LAWS OR REGULATIONS. 
 
IT IS THE USER’S RESPONSIBILITY TO OBTAIN ANY CERTIFICATION, RECERTIFICATION OR NEW 
CLASSIFICATIONS PERTAINING TO USE OF THE SOFTWARE AND HARDWARE. IF ANY WARRANTY OR CONDITION 
IS IMPLIED BY THE TRADE PRACTICES ACT 1974 (CTH) OR OTHER RELEVANT LEGISLATION WHICH MAY NOT BE 
EXCLUDED THEN OUR LIABILITY OF ANY BREACH OF SUCH AN IMPLIED WARRANTY IS LIMITED SOLELY TO THE 
RESUPPLY OF THE RELEVANT GOOD OR SERVICE OR PAYMENT TO YOU OF THE COST OF HAVING THE GOOD OR 
SERVICE PROVIDED AGAIN (AT OUR OPTION) . SOFTWARE AND HARDWARE INSTALLATION REMAINS THE SOLE 
RESPONSIBILITY OF THE VEHICLE OWNER. 
 
 
11. GENERAL  
This License is personal between you and Nistune Developments. It is not transferable except in accordance with this 
Agreement, and any attempt by you to rent, lease, sublicense, assign or transfer any of the rights, duties or obligations 
hereunder, is void. This Agreement and the conduct of the parties hereto shall be governed by the laws of  South Australia. 
 
YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY 
ITS TERMS AND CONDITIONS. YOU FURTHER AGREE THAT IT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF 
THE AGREEMENT BETWEEN YOU AND NISTUNE DEVELOPMENTS WHICH SUPERSEDES ANY PROPOSAL OR 
PRIOR AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN YOU AND NISTUNE 
DEVELOPMENTS RELATING TO THE SOFTWARE AND HARDWARE. 


